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Book Purpose and
Objectives



You can divide this book into two halves. The first thirteen chapters cover the basics of Revit Architecture 2024. The second half, from Chapter 14 to Chapter 25, covers the intermediate and advanced features of the software. This book demonstrates in very simple step-by-step procedures how to create a building model from scratch using all the tools the software offers.

At the completion of this book, the reader will be able to:

	Identify the difference between CAD & BIM


	Identify the different parts of Revit interface


	Draw and modify in Revit


	Prepare a new project


	Add and manipulate walls


	Insert doors and windows


	Create and manipulate curtain walls


	Create floors and roofs


	Add components and ceilings


	Add stairs, ramps, and railings


	Create views


	Create dimensions, text, and legends


	Visualize a model


	Create sheets and print them


	Create phases, design options, and path of travel


	Create and control toposurfaces


	Create Rooms and Areas


	Tag and create details


	Create Links, Import, and Export


	Create Masses, customize walls, floors, roofs, and ceiling families


	Create families


	Customize doors, windows, and railings


	Deal with worksets






Preface




Revit Architecture is considered by many to be the best BIM solution in the international market. Autodesk acquired the company in 2002 and the Revit user base is adding hundreds of thousands of users annually.  If you are studying at a university or work for a design or construction company, and have decided to use Revit Architecture, you’ve made the right choice.

This is a comprehensive book about Autodesk Revit 2024 Architecture. It will not teach the reader architecture design, which is a pre-requisite for this book. It can be used as an instructor-led or teach-yourself text-and-project book to help master the basics of Revit 2024 Architecture.

	We prepared two sets of exercises, one for metric units (mm) and the other for imperial (inch, ft).


	At the end of each chapter, you will find “Chapter Review Questions” that will help you test yourself.


	There are fifty-seven exercises integrated throughout the book, to help the reader implement what has been learned.


	Starting with Revit 2018, Autodesk changed the naming method and combined all of the Revit modules into a single product. So, when you buy the software, instead of Architecture, Structure, and MEP being separate modules, now one product contains all of them. Accordingly, this book teaches the Architecture part of Revit 2024.



IN THE COMPANION FILES



The companion files included with this book contain:

	A link to the Revit 2024 Trial version, which will last for 30 days starting from the day of installation. This version will help you solve all the exercises and workshops in this book. The student trial version can be extended beyond the 30-day period.


	Practice files and projects which will be your starting point to solve all exercises and workshops in the book. 


	Copy the folder named “Practices and Projects” onto the hard drive of your computer. In the Project folder, you will find two folders; the first is called “Metric” for metric units projects and the second one is called “Imperial” for imperial units projects. 


	Companion files are also available by writing to the publisher at  info@merclearning.com.







EXERCISES




	We prepared two sets of exercises, one for metric units (mm) and the other for imperial (inch, ft).


	The companion files include both sets of exercises. Copy the suitable set to your computer before you start reading this book.


	In the exercises, you will find the metric dimension first, then the imperial dimension within parentheses.


	The numbers are not necessarily equal.






CHAPTER 1

Introduction to
Revit 2024



This Chapter Contains



	CAD vs. BIM


	What is Revit?


	Revit interface


	Zooming in Revit


	Creating new files and opening existing files




CAD VS. BIM



	CAD means Computer Aided Drafting:

	When CAD was introduced in the early 1980s, it was revolutionary.


	In CAD we draft; we do not design or model.


	A line in CAD software could mean anything! It could mean the outer edge of a wall, an electrical wire, or a hot water pipe.


	In CAD, plans, sections, elevations, and details should be drawn in separate files. The collection of these files will be the design of your project.


	The sheets are not interrelated by any means except in the minds of the engineers who designed them.


	If one part of the project changes, the engineers must revisit all the related drawings and edit them manually.


	In CAD, groups of engineers from different disciplines use primitive commands to share their designs. 




	BIM means Building Information Modeling.


	This is the new approach to designing buildings.


	BIM is based on the concept of creating your model in 3D right away, using intelligent elements like walls, doors, windows, floors, ceilings, and roofs. The user will not use lines, arcs, or circles.


	Each element holds inside it an enormous amount of information. For example: a wall drawn in the Floor Plan holds inside it its height; hence, you see it in 2D as a plan, but when you visit the 3D view you will see it extending in 3D as well.


	Some elements because of their nature have the need to have a host, like a door and window need a wall to host them, and a lighting appliance needs a ceiling to host it.


	The BIM approach supports Parametric, which means intelligent elements understand their relationships with each other; when one element changes, the other elements connected to it will react accordingly.


	The BIM approach supports sharing the model information across users. Hence if an update is made for one user, all the others will know about it.


	All parts of the model are interrelated; a change in one part will reflect on all other parts. For example, moving one wall in the Floor Plan view will affect all other views; hence there is no need to go to each sheet and change it manually. Even the schedule views that hold the information of the quantities of the different parts of this wall will react accordingly.







REVIT ARCHITECTURE



	Revit Architecture is the best BIM solution for architects in the international markets these days.


	Revit Architecture is based on the idea of creating your whole model in a single file containing all the architecture elements; even if your model is very large, it will be in a single file.


	The Revit Architecture file will contain all the views of the 3D model that the user will create; hence floor plans, ceiling plans, sections, elevations, and schedules are all produced automatically.


	Revit Architecture is equipped with sharing and updating capabilities, which is unparalleled in today’s software technology. 


	Revit Architecture, Revit Structure (for structural engineers) and Revit MEP (for Mechanical, Electrical, and Plumbing engineers) are all in one package called Revit 2024; the three represent the ultimate BIM solution for all engineering disciplines.




STARTING REVIT 2024



	Start Revit 2024 using the shortcut that appears on your desktop.


	You will see the following screen:



[image: image]

	In this screen you can create a new project or open an existing project.


	You can also open an existing Family file or create a new one.


	At the top left of the screen, you can see the Home button:



[image: image]

	You can use the Home button to switch between the home opening screen and the drawing area


	Once you create a new project or open an existing one, you will see the following:



[image: image]

	The contents of this screen are as follows:

1. File Menu

2. Quick Access Toolbar

3. Ribbon

4. View tabs

5. Options Bar

6. Context Tab

7. Info Center

8. View Area

9. Status Bar

10. View Control Bar

11. Project Browser

12. Properties





UNDERSTANDING THE REVIT 2024 INTERFACE



	The Ribbons and File Menu will be your primary methods to reach commands in Revit 2024. 




File Menu

	Click on the File menu and you will receive the following:



[image: image]

	You will find all file functions needed to:


	Create a new project


	Open an existing project


	Save the current project


	Save As the current project under a new name and/or a different folder


	Export the current project to a different file format


	Print the current file


	Close all views of the current project, hence closing the project


	Start Options dialog box


	Exit Revit  2024







Quick Access Toolbar

	This is the small toolbar hanging at the top left part of the screen:



[image: image]

	Using this toolbar, you can:

	Open an existing file


	Save the current file


	Undo & Redo


	Print


	Create a PDF from Sheets and Views


	Activate Controls and Dimensions


	Measure between two references


	Align Dimension


	Tag by Category


	Add Text


	Open 3D View


	Create a Section


	Thin Lines


	Close Inactive Views


	Switch Windows




	If you click the arrow at the end, you will see the following:



[image: image]

	Using this list, you can add or remove commands. Also, you can Customize the Quick Access Toolbar.




Ribbons

	Ribbons consist of two parts:

	Tabs


	Panels






[image: image]

	For instance, the Architecture tab consists of seven panels: Build, Circulation, Model, Room & Area, Opening, Datum, and Work Plane.


	Some panels will have a small triangle near the title to indicate additional buttons; if you click it then you will receive the following:



[image: image]

	Some buttons may have a small triangle at the right part, meaning there are more options, such as in the following illustration:



[image: image]

	If you stay for one second over any button, you will see a small help screen appear, as shown in the following:



[image: image]

	However, if you stay for three seconds, you will see an extended help screen. Refer to the following illustration:



[image: image]

	Panels can be docked or floating. By default, all panels are docked. To make them floating, simply click the name of the panel, hold, and drag.


	While the panel is floating, there is a small button at the right side; the following image shows its function:



[image: image]

	Ribbons can be displayed differently on the screen by clicking the small arrow at the right repeatedly:

	You can see the panels and their contents:






[image: image]

	It displays a single button with the name of the panel. If you hover over it, it will show the contents of each panel alone:



[image: image]

	It will show only the name of the panel. If you hover over it, it will show the contents of each panel alone:



[image: image]

	The name of the tabs will be displayed; once you click it, Revit Architecture will show all the panels related to that tab:



[image: image]

	If you click the arrow beside the small button, you will see:



[image: image]

	In this list, you can pick any status you wish immediately without cycling.




Info Center

	At the top right part of the screen, you will see the Info Center, as shown in the following: 



[image: image]

	Info Center is the place where you can type any keyword(s) and Revit will search all its resources (online and off-line) to find you all the help topics related to your keyword(s).


	Other buttons are for signing into the Autodesk account, the Autodesk App Store, and the Help




View Area

	Revit is based on views.


	When you start a new project based on one of the given templates (architectural as an example), you will find (at least) two floorplan views, two ceiling plans, and four elevations views.


	You will always work on a view, which is your place to input Revit elements.


	The first step to start creating your model is to ask yourself, “am I in the right view?” If yes, go ahead. If not, go to the Project Browser, double-click the desired view, and then start working.


	You can open as many views in your project file as desired. 


	Each view will open in a view tab as shown below:



[image: image]

	This may slow down your computer; hence, you need to close views frequently. To close views use the (x) at the right of view name in View tab


	Or, you can go to Quick Access Toolbar and click the Close Inactive Windows button:



[image: image]

	Another way is to go to View tab and locate Windows panel, then click the Tile button to tile all the opened views:



[image: image]

	To browse between the opened views, you can use one of the following:

	[Ctrl] + [Tab]


	Go to the View tab, select the Windows panel, and click the Switch Windows button to see the following:





[image: image]

NOTE

	If you have a multi-screen setup, you can click and hold the view tab, and move it to the second screen.


	To move back to Tab Views, go to View tab, locate Windows, click Tab Views, as shown below:



[image: image]




Properties

	At the top left of the View Area, you will find Properties palette (of course, you can dock it anywhere else).


	This palette will show the properties of the selected element (Wall, Door, Roof, etc.). If there is no element selected, it will show the properties of the current view.


	Check the following two examples. The first one shows the properties of a wall and the second one shows the properties of the current floorplan:



[image: image]
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Project Browser

	Everything related to your project will be found in the Project Browser.


	You will find the following:

	All views (floor plans, ceiling plans, sections, elevations, 3D, rendering, legends, etc.)


	Schedules and Quantities


	Sheets


	Loaded families


	Created groups




	The name of the current view will be bold compared to the other views.




View Control Bar

	This bar is located at the bottom of view area, above the status bar:



[image: image]

	In this bar, you can control the scale of the view:



[image: image]

	Use the Detail Level button to control the view; you have three choices:

	Coarse


	Medium


	Fine



[image: image]

	Compare Coarse and Medium using the following figure (Wall):



[image: image]

	The Visual Style button will show different styles for the 3D view (you can see the effect in 2D views as well but not as clear as the 3D):



[image: image]

	Other buttons will be discussed later, each in its proper place.







Status Bar

	The last bar at the bottom will show different things:

	It will show you the next step after you start a command. For example, while you are in the Wall command, you will see at the left of the status bar “Click to enter wall start point.”


	The second part is the Workset part (advanced feature).


	The third part is the Design Options part (advanced feature).


	The rest are buttons for selecting elements and filters.







Options Bar

	When you start a new command or select an element, you will see this bar filled with information to help you finish your task correctly.


	For example, when you start the Wall command, the Options bar will look similar to the following: 



[image: image]

	These are all options related to creating a wall (which will be discussed later). 




NOTE

	By default, Revit comes with white background


	You can change it to black (along with other parts of the screen) using Dar Mode


	To do that, click File menu, select Options button, when the dialog box comes up, from the left pane, select Colors, using UI active theme, select Dark:



[image: image]





ZOOMING IN REVIT 



	The Mouse is the primary input device:

	The Left Button is always used to Select or Click.


	The Right Button has many purposes depending on what you are doing.





	The wheel in the mouse has zooming functions:

	Zoom in by moving the wheel forward.


	Zoom out by moving the wheel backward.


	Pan by pressing the wheel and holding, then moving, the mouse.


	Zoom to the extents of your model by double-clicking the wheel. 





	You can use the Zoom commands available in the toolbar at the right (though we think that using the mouse for zooming is much easier). Click the second button and you will see the following menu:



[image: image]

NOTE

Zoom All to Fit works if multiple views are opened and tiled. It will Zoom all elements in all views in one shot.




3D AND CAMERA IN REVIT 



	When you create a new file using one of the premade templates, there will be no 3D views.


	When you issue the 3D command for the first time, a new view called {3D} will be created. The default 3D view is Orthographic


	To issue the 3D view command, go to the Quick Access Toolbar and click the arrow beside the Default 3D View to see the following list:



[image: image]

	Click the Default 3D View button to see the 3D presentation of your model.


	At the top right of your screen, you will see the ViewCube:



[image: image]

	The ViewCube will allow you to view the 3D model from six orthographical views and from the edges and corners of the cube.


	To orbit the 3D model, hold [Shift], click and hold the mouse wheel, and move the mouse.


	To create an additional interior or exterior 3D view, create a camera.


	To create a camera, go to Quick Access Toolbar, click the arrow beside Default 3D View and select Camera option:



[image: image]

	Specify two points:

	Camera point


	Target point





	Once done, Revit 2024 will create a new 3D view (with a temporary name) and will make it the current view.




NOTE

 IIf you want to view your 3D model as Perspective, right-click the ViewCube and select Perspective, or use Camera (all Camera views are Perspective).




STEERING WHEEL



	The Steering wheel will allow you to navigate the model using different methods like zooming, orbiting, panning, walking, etc.


	To issue the command, go to the toolbar at the right and click Steering Wheel button, as shown in the following:



[image: image]

	Choose Full Navigation option and you will see the following:



[image: image]

	There are eight viewing commands, four located in the outer circle, and four located in the inner circle. The commands in the outer circle are:

	Zoom command


	Orbit command


	Pan command


	Rewind command





	In the inner circle, you will find:

	Center command


	Look command


	Up/Down command


	Walk command







Zoom

	This command will zoom in on the 3D (although using the mouse wheel will do almost the same job). Move your cursor to the desired location of your model, start the Zoom option, click and hold, move your mouse forward to zoom in, and move your mouse backward to zoom out.




Orbit

	This command is similar to the Zoom command. Move your cursor to the desired location, select the Orbit option, click and hold and move the mouse right and left and up and down to orbit your model.




Pan

	This command will Pan in 3D. Move your cursor to the desired location, select the Pan option, and click and hold and move the mouse right and left and up and down to pan over your model. 




Rewind	

	This command will record all your actions that took place using the other seven commands. Use it as if you are rewinding a movie. Start the Rewind command and you will see a series of screen shots; click and drag your mouse backward to view all your actions.




Center

	This command will specify a new center point for the screen. (You should always hover over an object.) Select the Center option, click and hold, and then locate a new center point for the current view; when done, release the mouse, and the whole screen will move to capture the new center point.




Look

	Assume you are in a place and you are not moving; your head is moving up and down, left and right. Move the cursor to the desired location, select the Look option, click and hold, and then move the mouse right and left and up and down.




Up/Down

	This command will go up above the model or down below the model. Move your cursor to the desired location and select the Up/Down option and you will see a vertical scale; click and hold and move the mouse up and down.




Walk

	For this command to be active, you need to be in Perspective view. It will simulate walking around a place; you will have eight directions to walk through. If you combine this command with the Up/Down command, you will get the best results. Move your cursor to the desired location, select the Walk option, and click and hold and move the mouse in one of the eight directions.


	The other versions of the Steering Wheel are mini copies of the Full Navigation:

	The Mini Full Navigation Wheel shows a small circle that contains all eight commands. 


	The Mini View Object Wheel shows a small circle that contains the four commands of the outer circle in the full wheel.


	The Mini Tour Building Wheel shows a circle that contains the four commands of the inner circle in the full wheel.


	Basic View Object Wheel 


	Basic Tour Building Wheel







NOTE

	While you are in the Perspective mode, you can use the Fly tool


	Fly tool will enable you to walk through a model and look around


	You can find it in the Navigation bar:



[image: image]





CREATE NEW PROJECT



	This command will create a new project based on a premade template.


	There are three ways to create a new project:

	From the starting screen, click New.


	From the Quick Access Toolbar, click New button.


	From the File menu, click New, then Project.





	Using any of the above ways, you will see the following dialog box:



[image: image]

	To ensure that you are using the right template, click Browse button and you will see the following dialog box (there is another set of templates for imperial units):



[image: image]

	Depending on the options you selected when you installed Revit, you will see the default templates or you will see other choices of templates.


	Revit template files have the extension *.rte


	Select the desired template and click Open to start a new file.




NOTE

	Start a new architectural project using the architectural templates.


	The first nine templates are for architecture


	There is a template for Multi-Displines called Default-Multi-Discipline_Metric.rte






OPEN EXISTING PROJECT



	This command will open an existing project for further editing.


	There are three ways to open an existing project:

	From the starting screen, click Open.


	From the Quick Access Toolbar, click Open button.


	From File menu, click Open, then Project.





	Using any of these three ways, you will see the following dialog box:



[image: image]

	Specify the hard drive and the folder your project resides in. Revit project files have the extension *.rvt.


	Click Open to open the desired project.




NOTE

 While opening any file, this dialog box will tell you in which version of Revit this file was created in.




CLOSING FILE(S)



	To close all opened views of a project, hence closing the project itself.


	Using the File Menu, select Close.


	Select whether to save changes or not. 




EXERCISE 1-1   INTRODUCING REVIT 2024



	Start Revit 2024.


	Open the file Exercise 1-1.rvt.


	Type the name of the current view: ________________________.


	Double-click the view named 00 Ground. Using different zooming commands, explore this view.


	Change the Detail level to Coarse, then Medium.


	What is the scale of this view? ________________________.


	Change it to 1:200 (1/16":1'), 1:50 (1/4":1'), then get it back to 1:100 (1/8":1').


	Create a camera for different parts of the model.


	Using the Quick Access Toolbar, click the 3D icon, then change the Visual style to Wireframe, Hidden, Consistent Colors, and then get it back to Shaded.


	Go to the 01 First view and select one of the walls (by clicking it), avoiding curtain walls.


	Check the Properties palette and record some of the information about this wall.


	Using the Project Browser, double-click on the East Elevation view.


	Using the View tab and the Window panel, tile all the opened views.


	Use the Zoom All to Fit command and see its effect.


	Select 00 Ground view. Click the Close Inactive Windows button to close all the other views. 


	Go to the 3D Section B-B and use the Steering Wheel to explore the 3D view. Change the view to Perspective so you can use both Walk and Fly


	Using the File menu and Close command, close the current project without saving. 




NOTES

















CHAPTER REVIEW




	One of the following is not Detail level:

a. Coarse

b. Fine

c. Shaded

d. Medium


	BIM means ____________________


	Project Browser contains all of the following except:

a. Floor plans

b. Schedules

c. Scale of the current view

d. Sheets


	If there were no selected elements, the Properties palette will show nothing.

a. True

b. False


	In CAD, we ____________________, we do not __________________.




CHAPTER REVIEW ANSWERS



1. c

3. c

5. Draft, Design




CHAPTER 2

 How to Draw And
 Modify in Revit



This Chapter Contains



	Drawing commands and drawing techniques


	Selecting in Revit


	Some Modifying commands



INTRODUCTION



	We will be exploring numerous drawing and modifying commands throughout the coming chapters.


	These commands share almost the same techniques, so we will dedicate this chapter to discussing these techniques only. 




DRAWING IN REVIT 2024



	While you are drawing walls (for example) in Revit 2024, the following will assist you in doing your job accurately:

	Temporary dimensions


	Alignment lines


	Snaps


	Draw context panel







Temporary Dimensions

	Temporary dimensions appear in two different situations:

	When you are drawing walls in floor plans, you will see the length of the wall and its angle measured from the east (180° counterclockwise, and 180° clockwise), as shown in the following example:



[image: image]

	In this mode, you are allowed to input the value of the length by typing.


	You will see the second type of temporary dimension after you finish drawing the wall. If you click the wall, you will be allowed to change the temporary dimension, as demonstrated in the following:



[image: image]

	Click the small blue circle to change the position of the dimension from the outer edge, inner edge, or center of the wall.


	The small shape beside the dimension is used to convert the temporary dimension to a permanent dimension:






[image: image]


Alignment Lines

	When you draw several walls, Revit will help you align the new wall to any existing wall, as shown in the following example:



[image: image]


Snaps

	Revit allows you to snap to any element, as in snapping to endpoints, the midpoint of a wall, or the intersection of two elements.


	By default all snaps are on.


	To control Snaps go to Manage tab, locate Settings panel, and click Snaps button:



[image: image]

	You will receive the following dialog box:



[image: image]

	In this dialog box you can do all/any of the following:

	Turn on/off any desired snap.


	Change the length dimension snap increment. The different values will work according to the zoom level. When you are closer you will use the lesser value.


	Change the angular dimension snap. The level of zoom applies here as well.


	Use the Temporary override by using the keyboard shortcuts; for instance, SC is used to snap to the center of an arc or circle element.







Draw Context Panel

	When you start any command in Revit that includes drawing, you will see receive the following (depending on the command, you may see less or more tools):



[image: image]

	The panel includes tools to help draw shapes such as:

	Line tool, to draw straight shapes. If you want to draw continuous lines, make sure Chain option (which appears in the Options bar) is turned on.


	Rectangle tool, to draw a rectangle shape using two opposite corners.


	Two types of polygons (Inscribed and Circumscribed)


	Circular shape


	Three types of circular arcs


	Fillet arc (to add an arc to two lines)


	Select existing lines


	Pick Faces





	More of these tools will be discussed when we tackle other commands.





SELECTING IN REVIT



	There are three ways to select elements in Revit Architecture:

	Click on the desired element.


	Click on an empty space, hold the mouse, and go to the right to form a Window. Elements contained fully inside the Window will be selected.


	Click on an empty space, hold the mouse, and go to the left to form a Crossing. Elements crossed by or contained fully inside the Crossing will be selected.





	The following is an example using the Window technique:



[image: image]

	The following is an example using the Crossing technique:



[image: image]

	You can add and remove from the selection set as follows:

	Hold [Ctrl] key to add more elements to the selection set. You will see the cursor with the add sign.


	Hold [Shift] key to remove elements from the selection set. You will see the cursor with the subtract sign.





	Depending on what method you use, a green context tab will appear, which resembles the following:



[image: image]

	Under the panel called Modify, you will see all modifying commands, like Move, Copy, Rotate, and so on. This method of selecting elements before issuing the modifying command is favorable when using Revit.


	At the right under Selection panel you can see Filter button. This button is very important when you select multiple elements; it will help you segregate the contents as you wish. Click Filter and you will see the following dialog box:



[image: image]

	In the above example, your selection contains five walls, two doors, and two windows. You can use the two buttons at the right to either check them all or uncheck them all, or you can use the checkbox at the left to make your own decisions.




Delete Command

	When you want to delete any element in Revit, simply select it and press the [Del] key on the keyboard.





EXERCISE 2-1  DRAWING AND SELECTING




	Start Revit 2024.


	Open the file Exercise 2-1.rvt.


	Change the Detail Level to Medium.


	Start Wall command.


	Make sure you are using Line tool from Draw context panel.


	Somewhere between the East and South elevation symbols, click and go to the left, make sure you are using angle of 180°, and set the distance to 20000 (66').


	Go up and set the distance to 16000 (52').


	Go to the right and set the distance to 4000 (14').


	Select Start-End-Radius Arc. The start point is already known, so go to the right to a distance of 12000 (38'), click to set the endpoint of the arc, and then move up to specify the radius which is 6000 (19') (the mouse will snap to the right distance).


	Change the tool to Line and complete the following shape:

[image: image]


	Click the right vertical wall to discover that the inside-to-inside distance of the walls is 19650 (64'-10 1/8"). Change this value to 21000 (66'-6").


	Start Wall command, but this time, change the Type to Generic 225 Masonry (Generic-8" Masonry).


	Measuring from the lower horizontal wall from its left, click to start the wall at a distance of 3000 (9'-6"), then go to the right by 3000 (9'-6"), and finally close down to the horizontal wall to create the following shape:

[image: image]


	Make sure that the inside-to-inside distance of the room is 3000×3000 (9'-6" × 9'-6")


	Start Door command and add a door like the following, making sure the distance between the wall and the door is 200 (1'):

[image: image]


	Add two windows like the following, bearing in mind that the two windows are exactly at the mid-distance between the walls:

[image: image]


	Using Window selection method, select only the interior walls, the door, and the two windows. Click Filter in the Multi-Select context tab, and deselect Walls and Doors. What are the selected elements now? ______________
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